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Unit Standard 2792 (Version 7) 
Produce simple desktop published documents using templates - Publisher 2010 
 
This book covers the course outline for the following New Zealand Qualifications Authority Unit 
Standard: 
 
Unit Standard 2792 - GENERIC COMPUTING (Level 1, Credit 2) 

Produce simple desktop published documents using templates  
(version 7). 

 
All topics in this Unit Standard are included in this book. 
 
Retrievable exercise files are used with this book.  These are available for free download from 
our web site at www.cherylprice.co.nz.  Instructions for downloading are included on the next 
page. 
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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

  

 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 
Click in the Product Search box and type the number of 
this unit standard, as shown at the right. 

4 Click on     

5 Click on   

6 
Under the Exercise Files heading click on the underlined blue hyperlink, ie     
Book Exercise Files – V7 Publisher 2010  Free Download 
The File Download dialog box will display.   

7 If you have Winzip use the following instructions otherwise move to step 8. 

 a   Click on  .    

 
b   Click on the  of the  button. 

 
c If My Documents folder is not displayed click on Set default unzip folder at the 

bottom of the list.  Ensure My Documents is selected then click on Select 
Folder. 

 d Click on the  of the  button and click on the My Documents folder.   
The files will be unzipped. 

8 
Click on  then click on the Documents 
folder shown at the right. 

Click on  

9 
Click on Open Folder which will display My Documents folder.  Right click on the 
zipped exercise file and select Extract All. Click on Extract.  A folder will be created 
containing the exercise files.   

US 2792 

US 2792 
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Changing Defaults 
Default settings may have already been changed in your Publisher 2010 program.  You can check 
these and change them if necessary as follows.  We have used the following defaults throughout 
this book, ie Arial font, 12 pt font size and paragraph options with 0 pt Line spacing, After 
paragraphs and 1 sp Between lines. 
 

Font and Font Size 
You can check if the font and font size have been changed by looking at the Font box on the 
Home tab.  If it shows  then it has not been altered.  Change the default font to 
Arial 12 pt (or another font, eg Times New Roman 12 pt) as follows: 

1 In a new publication click on the Insert tab and then on .  Draw a text box in your 
publication. 

2 On the Home tab click on  

3 Scroll down the list of styles until you see Normal.  Right-click 
and select Modify as shown at the right.  

The Modify Style dialog box will be displayed as shown below. 

 

4 Click on  and select Arial 12 pt (or font of your choice).  Click on 
OK. 

5 Click on .  Change the Before 
paragraph: option to 0 pt and Between lines: to 1sp as 
shown at the right.  Click on OK. 

6 Delete the text box by pressing the Delete key. 

7 Click on the File tab and select Save As.  You need to type the pathname of the location of 
your Publisher templates which is usually the following: 

C:\Users\User Name\AppData\Roaming\Microsoft\Office\normal.pub  

8 Click on the Save button.   
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Unit Standard 2792 (Version 7) 
 
 

Title Produce simple desktop published documents using 
templates 

Level 1 Credits 2 

 

Purpose People credited with this unit standard are able to produce, 
proof and print simple desktop published documents using 
templates. 

 

Classification Computing > Generic Computing 

 

Available grade Achieved 

 
Explanatory notes 
 
1 This unit standard covers the creation of three desktop published documents, 

each with the support of a template (or templates).  It does not assess design in 
terms of layout. 

 
2 Specifications for each document will be provided and must include but are not 

limited to – size and orientation, type and purpose of document, use of colour, 
file management, print layout requirements. 

 
3 Legislation relevant to this unit standard includes but is not limited to the: 

Copyright Act 1994; 
Copyright (New Technologies) Amendment Act 2008; 
and any subsequent amendments. 

 
4 An assessment resource to support computing unit standards (levels 1 to 4) can 

be found on the NZQA website at www.nzqa.govt.nz/asm. 
‘The Computing Process - a clarification document’ and a specific combined 
brief and task resource for assessing against unit standard 2792 can be found 
on the NZQA website. 

 
Outcomes and evidence requirements 
 
Outcome 1 
 
Produce simple desktop published documents using templates. 
 
Evidence requirements 
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http://www.nzqa.govt.nz/providers-partners/assessment-and-moderation/assessment-of-standards/assessment-support-material/generic-computing-levels-1-to-4/computing-process/
http://www.nzqa.govt.nz/assets/Providers-and-partners/Assessment-and-moderation/Assessment-of-standards/brief-task-2792.doc
http://www.nzqa.govt.nz/assets/Providers-and-partners/Assessment-and-moderation/Assessment-of-standards/brief-task-2792.doc


iv 

1.1 Templates selected are appropriate for the type and purpose of the 
document. 

 
1.2 Graphics and text are selected, oriented and sized according to the 

supplied specifications. 
 
1.3 Colour is selected and used according to the supplied specifications. 
 

Range may include but is not limited to – font colour, fill colour, 
background colour, image colour. 

 
1.4 The document files are managed according to the file management 

specifications provided. 
 

Range may include but is not limited to – file type, file name, file 
location. 

 
Outcome 2 
 
Proof and print the documents. 
 
Evidence requirements 
 
2.1 The documents are proofed and edited, as required, to meet the supplied 

specifications. 
 
2.2 The documents are printed in accordance with the supplied specifications. 
 
 

Planned review date 31 December 2016 

 
Status information and last date for assessment for superseded versions 
Process Version Date Last Date for Assessment 
Registration 1 30 September 1994 31 December 2013 
Review 2 24 September 1997 31 December 2013 
Revision 3 28 July 1998 31 December 2013 
Review 4 30 July 2002 31 December 2013 
Revision 5 16 July 2004 31 December 2013 
Review 6 22 May 2009 31 December 2015 
Rollover and 
Revision 7 19 September 2013 N/A 

 
Consent and Moderation Requirements (CMR) reference 0226 

 
This CMR can be accessed at http://www.nzqa.govt.nz/framework/search/index.do. 
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Exercise Files used in this book 
 
(Instructions are at the front of this book for downloading retrievable files from our web site.) 

 
 

Names of files 

Anniversary Horseshoe Jones Plumbing Logo 

Flowers by Anne Logo Roses 

Flowers To Mom 

Grandchildren Swan Lake Ballet 

John and Lynne  
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© Cherylprice.co.nz Limited SECTION 1      1 

 

Theory 
Getting Started with  
Microsoft Publisher 2010 
 

 
 
Learning Outcomes 
 
At the end of this section you should be able to -  
 

 

 Identify desktop publishing tools 

 Identify different types of publications 
 

 Start and exit Microsoft Publisher 2010 

 Understand the Microsoft Publisher 2010 screen and options 

 Create a Christmas card and birthday card 

 Understand Microsoft Publisher 2010 tabs 

 Read about proofing and editing a document, paper styles, sizes and folds 

 

Section 
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2    SECTION 1 © Cherylprice.co.nz Limited 

Desktop Publishing Information 
Desktop publishing software enables the production of documents, magazines, newspaper pages, 
etc to be achieved using a computer and a high quality printer, eg laser printer.  Various kinds of 
graphics can be printed on the same page and lines, boxes, shading and colour can be incorporated. 

The printed output can be distributed as it is, photocopied or scanned, or it can be used as camera-
ready copy for an offset printer. 

The concept of producing a document using desktop publishing software is entirely different from 
that used in word processing programs.  Desktop publishing techniques require the layout of a page 
to be planned in advance, to allocate areas for pictures, graphic displays, etc.  Text and/or graphics 
can be imported from other programs. 

Equipment required: 

Computer with a hard disk and desktop publishing software. 

Mouse - Use a mouse for drawing boxes, lines, moving graphics and text around the page.  When 
using menus, a combination of shortcut keys and mouse can be used. 

Printer - A good quality printer is essential, usually a laser or ink-jet. 

Optional - Scanner for photographs, drawings, etc from other documents to be incorporated.  Digital 
camera. 

 

 
Desktop publishing programs currently in use include: 

• Microsoft Publisher 2010 
• Microsoft Office Publisher 2007  
• PageMaker 7.0  
• Corel Ventura 10 
• QuarkXpress 6 
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© Cherylprice.co.nz Limited SECTION 1      3 

Desktop Publishing Tools 

 
A desktop publisher uses specific tools to produce a publication - computer, monitor, keyboard, 
mouse, printer, scanner and sometimes a digital camera. 
 
The basic set up for desktop publishing is shown below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Computer 
A computer used for desktop publishing needs to be powerful, as many publications will require 
additional memory.  Complex graphics and lengthy publications use a large portion of the resources 
of a computer.  A PC computer with at least 1 GB (Gigabyte) of RAM (Random Access Memory) 
and a large hard disk drive is required to store desktop publishing programs, together with graphics 
and publications.  A USB drive or CD ROM/Writable drive can be used to store additional graphics 
and publications as required. 
 

Large Monitor 
A large monitor can display an entire page of a publication without the user having to zoom in to 
view text/objects.  This prevents headaches and eyestrain. 
  

Scanner 

Large 
Monitor 

Printer 

Computer 
(which is often 
on the floor) 

Digital 
Camera 
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4    SECTION 1 © Cherylprice.co.nz Limited 

Printer 
A high quality printer is necessary to print the final copy of a publication 
unless you are sending the file to a print service bureau.  Your printer will 
need to have sufficient memory to interpret the publication/graphic.   

The print speed can vary and is measured in PPM (Pages Per Minute).  
However the speed of the printer is not as important as quality and memory 
capability. DeskJet and Laser printers (sometimes with colour facilities) 
produce a high quality of print and are commonly used by desktop publishers. 

The print quality will vary from printer brand to printer brand.  DPI stands for Dots Per Inch - the 
higher the number of dpi the finer the printer - 600 dpi is finer than 300 dpi.   
 

Scanner and Digital Camera 
A scanner can take a copy of an image and place a copy of that image into your 
computer. It can be edited and adjusted as required, then positioned in a 
publication.  The scanner shown at the right is called a “flat bed scanner” as it sits  
on a desk.  You can also purchase scanners that can be held in the palm of your 
hand - called “hand held scanners”.  These are not so easy to use and do not tend to 
produce good scanned images. 

A digital camera allows you to take photos and then transfer the photos into your computer.   
The photos can be edited and adjusted as required, then used in a publication. 
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© Cherylprice.co.nz Limited SECTION 1      5 

Templates 
A template is a blue print or an outline for a publication that you will create.  It includes colour 
schemes, font schemes, sample text etc that you can change. 
 
There are several different types of templates that can be used to create publications in Publisher.  
Templates marked with an * are created in this book using step by step instructions.  (Additional 
publications such as Signs are also created.) 

The templates in Publisher include pre-designed publications with options that allow you to 
customise a publication to suit your needs, eg if you choose a thank you card you can select the style 
of card, colour, card message, etc. 

  
 

 

The template that you choose should be appropriate to your target audience.  For example you would 
not select a brightly coloured certificate with hearts on it for a person who has just completed a 
business course.  

Template 
groups 
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6    SECTION 1 © Cherylprice.co.nz Limited 

Cards* and Invitations* 

Publisher has templates for creating greeting and invitation cards.  These are created 
using a single A4 page which is folded into an A5 card.  To view some of the different 
cards available in Publisher see Paper Styles and Folds on page 8.  

 

 
Cover, Inside Pages, Back 

 
Banners* 

A banner is a sign that is short and wide, which will typically stretch across a doorway or be hung 
up on a wall.  Banners are used to help decorate a room and express a message, eg Congratulations, 
Welcome or Happy Birthday.   

 

 
Calendars* 
A calendar template in Publisher can be a monthly or annual calendar that displays the days or 
months in a year.  You can choose a monthly calendar where each page of the document displays 
the days in a month.  An annual calendar will display the months of the year on one page.   

Wallet size calendars are also available.   

Calendars can be customised by adding in your own name, address, pictures, etc.  You can also 
choose which months and years you require. 

   
 One month per page One year per page 
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© Cherylprice.co.nz Limited SECTION 1      7 

Flyers* 

Flyers can be produced in Publisher using the Quick Publications option or using a Flyer template.  
A flyer is mostly used to advertise a special offer, special event, garage sale, etc.   

 

Certificates* 

Award Certificates are great for acknowledging those who have achieved success, or to acknowledge 
that they are appreciated when they have done something.  There are several different styles of 
templates available that you can enter details into and customise to suit your own needs.  You can 
also create Gift Certificates. 

 
 

Brochures 

Brochures are usually a folded A4 page with information about a product or service.  They 
are used to advertise/promote a product or service.  The most common brochure in 
Publisher is the three panel brochure shown below. 

 

  
Inside, Outside 
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8    SECTION 1 © Cherylprice.co.nz Limited 

 

Portrait 

Landscape 

  
Paper Styles and Folds 

In Publisher you can create documents that can be folded to create cards and print documents that 
have been designed for unusual paper sizes (styles).  A selection of paper styles and folds are shown 
below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 
Orientation 
 
Orientation is how the page is set up to display content, eg portrait orientation is used to describe 
the page orientation that is the same as a portrait painting (long and narrow) and landscape 
orientation relates to a landscape painting which is short and wide. 
 
 

Business 
Card 

Tent Card 

Top Fold Card 

Side Fold Card 
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© Cherylprice.co.nz Limited SECTION 1      9 

Starting Microsoft Publisher 2010 
Exercise 1 

1 Click on the Start button  (located in the bottom left corner of the screen). 

2 Move the mouse pointer to All Programs. 

3 Move to Microsoft Office, and then to Microsoft Publisher 2010, as shown below, and click. 

 
 

After you have used Publisher a few times Microsoft Publisher 2010 will be displayed on the Start 
button on the list of programs that is displayed above All Programs. 

 

Exiting Microsoft Publisher 2010 

Double click on the Control Menu Box  at the top left of the screen 

OR click on the  tab and choose  

If you have not saved all open publications before exiting Publisher the following dialog box 

will appear on the screen. You would then click on . 

 

Note 
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10    SECTION 1 © Cherylprice.co.nz Limited 

Microsoft Publisher 2010 
Publisher 2010 is an easy-to-use desktop publishing application.  The tools in Publisher allow for 
the production of documents, magazines, newspaper pages, etc.  Text and various types of graphics, 
including lines, boxes and shapes can be printed on the same page. 
 
Creating desktop published publications is different from creating word processed documents in that 
planning is required to determine where the text, graphics and other elements will be positioned on 
the page.   

Each time you enter Microsoft Publisher the  tab, New option will display the Available 
templates gallery which shows publication types and provides access to Recent Publications (as 
shown below).  (If this is not displayed ensure Show the New template gallery when starting 
Publisher checkbox is checked in the File tab, Options, General.)  

On the File tab, a list of common commands including Save, Open and Close are shown to the left, 
as well as access to Recent publications and Print features.  The main portion of the screen shows 
the different types and styles of the available publications. You would select the type of publication 
you wish to create, or a specific template for the publication, then click on the Create button to start 
the publication. 

Alternatively, if you are opening an existing publication you can select this from the Recent section  
accessed in the left navigation pane as indicated below (OR you can use the Open option). 

The Available templates gallery will close when an option has been selected and a publication is 

created/opened.  You can return to this screen by clicking on the  tab, and clicking on New 
to the left. 
 

 

  
 

When you have selected an option for a new publication and clicked on Create, the Publisher screen 
where you create your publication will be displayed, as shown on page 12. 
 

Recent 
Publications 

Available 
Templates 

Template 
groups 
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© Cherylprice.co.nz Limited SECTION 1      11 

 Publication Templates  
In the following exercise you will create a Christmas card using a Publication Template.  

Exercise 2 

1 In the Most Popular group of the Available Templates gallery, click on Greeting 
Cards as shown at the right.  The Greeting Cards screen is displayed. 

2 Click on  which displays installed templates in holiday categories. 

3 Drag the scroll box (shown at the right) down the list of templates until you see 
Christmas cards as shown below.  

4 Click on Christmas 12 as indicated. (A sample is shown at the top right of the window.) 
 

 

5 In the Customize section at the right, click on the at the right of the Color 
scheme:  box and select Mistletoe as shown at the right.  (You will accept 
other options as shown in the Customize area.) 

To return to the main Available Templates window you can click on  (at the 
top of the window). 

6 Click on   at the bottom right of the screen.   

The Christmas card will be displayed on the Publisher screen as shown on the next page. 

Select  
Christmas 12 

Note 
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12    SECTION 1 © Cherylprice.co.nz Limited 

The Microsoft Publisher Screen 
The following diagram displays the Microsoft Publisher screen and listed under are details of this 
window. 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Control Menu Box 

Double clicking on the Control Menu box  will close the Microsoft Publisher 2010 program.  
 

Title Bar 
The name of the publication file is displayed on the window title bar when it is saved. 

Close, Restore Minimize and Maximize Buttons 

Buttons used to increase (maximize) the size of the main window (Microsoft Publisher) and reduce 
the main window to an icon (minimize). The Restore Down Button is used to restore the window to 
its former size. Clicking on Close exits Microsoft Publisher. 

Publisher Help 

If you need to know more about a feature, or are having problems with a task, Help may be able to 
provide answers to your questions. 

Minimize Ribbon 
Collapses the ribbon and provides additional working space for your publication. 

Scratch Area 
An area outside the page used as a temporary storage place for graphics and/or text. 

Restore Down 
Minimize Close 

Publisher 
 Help 

Minimize 
Ribbon 

Scratch 
Area 

Scroll 
Box 

Vertical 
Scroll Bar 

Zoom 
options 

View 
buttons 

Show 
Whole Page Horizontal 

Scroll Bar 
Position and 
Size Indicators 

Page 
Indicator Status 

Bar 

Page 
Navigation 
Pane 

Rulers 

Control Menu 
Box 

Quick Access 
Toolbar Title Bar 

Ribbon 

Tabs 
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